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Ejercicio 1: QGIS-Fire Mapping Tool (FMT) 

Objetivos 

• Entender cómo usar del plugin “QGIS FMT” para monitorear incendios forestales 
• Aprender cómo ajustar imágenes pre- y post-incendio para compararlas 
• Entender cómo identificar y delinear el límite perimetral de un incendio 
• Aprender cómo crear imágenes de la tasa de quema normalizada diferenciada 

(differenced Normalized Burn Ratio o dNBR) y dNBR relativa (RdNBR)  
• Aprender los fundamentos de cómo crear un mapa de la severidad de quema 

temático incluyendo identificación de umbrales  

Resumen de Temas 

• Descargar el FMT  
• Configurar la carpeta FMT y las configuraciones para la base de datos 
• Cargar imágenes pre-y post-incendio para el incendio Paradise 
• Ajustar los parámetros de la visualización de imágenes pre- y post-incendio para 

hacer comparaciones 
• Digitalizar el límite del incendio Paradise 
• Crear una imagen de la dNBR y de la RdNBR 
• Generar un mapa de severidad de quema temático 

Herramientas Necesarias 

• QGIS 2.18 o anterior para Windows OS 
NO use la nueva versión de QGIS 3.2 

• Plugins QGIS  
o Zonal Statistics (incluido con la instalación estándar de QGIS, pero hay 

que habilitarlo) 
o Processing (incluido con la instalación estándar de QGIS, pero hay que 

habilitarlo) 
o QSpatialLite (opcional en la instalación estándar de QGIS y hay que 

instalarlo y habilitarlo) 
• Recomendaciones y requisitos sistemáticos: 

o Sistema Operativo: Windows XP/Vista/7/8/10 
o Memoria (RAM): Requiere 1GB de RAM  
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o Espacio en el Disco Duro: Requiere 10GB de espacio libre 
o Procesador: 1.6GHz o más rápido 

Datos Asociados 

Todos los datos asociados serán incluidos en la descarga del FMT Plugin de la página 
en línea Monitoring Trends in Burn Severity (MTBS) aquí: https://www.mtbs.gov/  

Introducción 

Para este ejercicio vamos a utilizar el Plugin Fire Mapping Tool (FMT) de QGIS para 
evaluar un incendio forestal que ocurrió en el Parque Nacional Olímpico denominado el 
incendio Paradise. Este incendio, ubicado dentro de un bosque húmedo, fue causado 
por un rayo en mayo de 2015 y ardió hasta noviembre del mismo año. En este ejercicio, 
vamos a usar datos de Landsat de antes y después del incendio para determinar el 
perímetro del incendio, la extensión del área quemada y la severidad de quema 
estimada. Aunque el proyecto Monitoring Trends in Burn Severity (MTBS) mapea 
incendios de escala mayor, a menudo tarda entre uno y dos años para hacerlo, lo cual 
no es lo suficientemente rápido para que los gestores de suelos locales reaccionen a 
los cambios.  

Este plug-in para la evaluación de incendios, FMT, fue desarrollado con la finalidad de 
dirigirse a las necesidades de quienes se ocupan de la gestión de incendios locales 
que no pueden esperar hasta la publicación de una evaluación por MTBS o necesitan 
determinar el efecto de incendios menores. Este plugin permite que quienes se ocupan 
de la gestión de incendios locales utilicen el mismo tipo de imágenes satelitales e 
información derivada que los analistas de MTBS. Esta herramienta emula la 
herramienta Event Mapping Tool (EMT) desarrollada por el Centro de Aplicaciones de 
Teledetección del Servicio Forestal de EE UU (USFS Remote Sensing Applications 
Center) la cual utilizan los equipos de MTBS del USFS y USGS (Servicio Geológico de 
EEUU). Se le han agregado funcionalidades adicionales y que sea de fuente abierta 
permite su distribución libre. 

Este ejercicio contendrá un sub-set de las funcionalidades disponibles en el FMT. 
Puede encontrar más información sobre el proceso de evaluación en la guía del usuario 
de QGIS FMG (User Guide) en el paquete de descarga.  

Resumen del Mapeo de Inundaciones 
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Los científicos que estudian los incendios pueden usar datos de Landsat para evaluar 
la extensión y variación de incendios forestales. Los satélites Landsat registran la luz 
reflejada de cada parcela de 30 metros de la superficie de la Tierra en varias “bandas” 
espectrales, tales como azul, verde, roja, infrarroja y más. Cada “pixel” de 30 metros es 
un promedio espectral de todas las “cosas”: rocas, árboles, caminos, grama, cultivos 
etc. dentro del pixel. En los ambientes silvestres hay pixeles puros de bosque, matorral, 
pastizal etc. Y pixeles “mixtos” que contienen varios tipos de cobertura terrestre. 

Algunos de los procedimientos delineados aquí siguen los protocolos utilizados por el 
proyecto Monitoring Trends in Burn Severity (MTBS, www.mtbs.gov). Se puede 
encontrar un repaso comprensivo de la evaluación de incendios del Servicio Forestal 
de EEUU en línea. Después de identificar la fecha y la ubicación de un incendio, el 
proceso general es: 

● Determinar la estrategia de evaluación 
● Evaluar el “Verdor Máximo” (“Peak of Green”) y ordenar imágenes de Landsat  
● Pre-procesar las imágenes de Landsat  
● Seleccionar las escenas que mejor corresponden para el análisis 
● Generar la imagen de cambios (imagen pre-incendio menos la imagen post-

incendio) 
● Evaluar la imagen de cambios para estimar la severidad de quema 

 
Estrategias para la Evaluación de Incendios 
Una vez que adquiera la información de la ubicación y la fecha, un(a) analista puede 
comenzar a buscar imágenes de Landsat adecuadas. Para archivos más grandes, es 
suficiente utilizar imágenes de menor resolución disponibles a través de GloVis. La 
búsqueda de archivos más pequeños entre imágenes de Landsat podría requerir el uso 
del LandLook Viewer, el cual ofrece imágenes de mayor resolución. Tanto GloVis como 
LandLook tiene limitaciones, las cuales trataremos en mayor detalle a seguir. 

Si no se nota una cicatriz de quema en la ubicación dentro de una escena de Landsat 
sin nubes adquirida prontamente después de la fecha de ignición, puede que el 
incendio sea demasiado pequeño para ser visto por satélite, los efectos sean mínimos, 
el área se encuentre bajo la copa o el dosel arbóreo, la ubicación reportada sea 
incorrecta, o la fecha de ignición sea incorrecta. El(la) analista debe revisar el área 
adyacente a la escena para determinar si hay algún área quemada en las 
inmediaciones (dentro de 5 – 10 km) o en adquisiciones posteriores. Si el área 
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quemada es visible en datos Landsat inmediatamente post-incendio, hay que 
determinar cuáles imágenes Landsat adicionales podrían ser necesarias para evaluar 
la severidad del incendio.  

En los datos de Landsat, las bandas espectrales roja, casi-infrarroja e infrarroja onda 
corta son útiles para evaluar las condiciones de la vegetación y los efectos de los 
incendios. La evaluación de la severidad de quema se basa en evaluar la cantidad de 
cambios que ocurrieron debido al incendio. Esto requiere la comparación de imágenes 
pre- y post-incendio adquiridas durante etapas fenológicas similares. Para cada 
escena, se crea la Tasa de Quema Normalizada (Normalized Burn Ratio o NBR) se le 
resta la imagen de la NBR post-incendio a una imagen de la NBR pre-incendio para 
crear una NBR diferenciada, (dNBR) la cual sirve para evaluar la cantidad de cambios 
en la vegetación y el suelo resultantes del incendio (vea la figura 1). 

 

Figura 1: Creación de la dNBR. Un mayor valor dNBR corresponde a una mayor 
severidad de quema. 

Los satélites Landsat adquieren una imagen cada 16 días sobre cualquier punto en 
particular. Actualmente hay dos satélites Landsat en órbita, Landsat 7 y 8, así que las 
imágenes se recolectan cada ocho días. Hay muchas imágenes Landsat para elegir y 
es importante seleccionar las mejores. Hay diversos factores que determinan cuáles 
son las mejores imágenes -- por ejemplo, el tipo de cobertura terrestre y la temporada 
en la que ocurrió la quema – dependiendo de su estrategia evaluativa preferida. 
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Máximo de Verde  
El Máximo de Verde (Peak of Green) es un concepto importante para la evaluación de 
la severidad de quema. Después de que un incendio se apaga, la vegetación que 
sobrevive comienza a recuperarse o eventualmente se muere. Seleccionar una escena 
Landsat en el punto máximo de verde después de un incendio permite discernir esos 
efectos. Los proyectos Greenness Mapping (Mapeo del Verdor) y Remote Sensing 
Phenology (Fenología por Teledetección) del Servicio Geológico de EEUU (USGS) 
recolectan datos del Índice de Vegetación de Diferencia Normalizada (Normalized 
Difference Vegetation Index o NDVI) de 1 km adquiridos vía satélite y los recopilan 
bisemanalmente para EE UU continental (CONUS) para retener el valor NDVI máximo. 
Para cada categoría que se encuentra dentro de la escena Landsat, se determina el 
valor NCVI bisemanal medio y se diagrama en un gráfico, mostrando el momento del 
máximo de verde y el valor de éste. Las curvas representan el NDVI medio sobre toda 
la escena Landsat y se pueden visualizar en la página https://mtbs.gov/ndvi-graphs. 
 
Hay varias opciones de evaluación e imágenes para cualquier archivo en particular. 
Una vez que determine la estrategia de evaluación preferida, utilice las imágenes 
disponibles en línea para seleccionar las escenas apropiadas. Es de preferencia utilizar 
escenas adquiridas en el momento de mayor verdor o cerca de éste. 

Tomando en cuenta las imágenes de baja resolución y la naturaleza generalizada de 
las curvas de verdor del NDVI, ordene varias imágenes “candidatas” de Landsat pre- y 
post-incendio. Es deseable tener imágenes opcionales accesibles si es que hay algo 
que no se ve en las imágenes, por ejemplo, una nube pequeña y una sombra en medio 
del incendio o una correspondencia fenológica menos que ideal.  

Para comenzar una evaluación, utilice la interfaz GloVis estándar y las curvas del NDVI 
para repasar y entender la cronología (meses y años) para las imágenes pre y post-
incendio. Por ejemplo, el máximo de verde generalmente ocurre entre junio y agosto. 
Nota: Los datos de la curva del NDVI están disponibles SÓLO para escenas Landsat 
dentro del CONUS. 
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Parte 1: Adquiera el Plugin QGIS FMT y Configure su Espacio de 
Trabajo  

Descargue el FMT Plugin 

1. Vaya a la página de Monitoring Trends in Burn Severity (MTBS): 
https://www.mtbs.gov/ 

2. Haga clic en Tools, después seleccione QGIS Fire Mapping Tool 

 
3. Haga clic en Download Tool & Documentation 

 
4. Descomprima la carpeta QGIS_FMT_Plugin_V1_0_1 y guárdela en su 

computadora.  
a. Para Windows: Copie la carpeta FMT al directorio plugins para QGIS. Se 

encuentra aquí: C:\Users\<username>\.qgis2\python\plugins 
i. Posiblemente tenga que crear la carpeta para plugins dentro de 

este directorio  
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Inicie QGIS en Su Computadora  

5. Abra QGIS y abra un nuevo mapa  
6. Haga clic en Plugins y después en Manage and Install Plugins 
7. Vaya a Settings y marque Show also experimental plugins 

 

 
8. Ahora vuelva a abrir Manage and Install Plugins y haga clic en All, el cual 

debería mostrar una lista de todos los plugins disponibles (Si el plugin no 
aparece en la lista, cierre la ventanilla y reinicie QGIS). 
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9. Señale FMT para crear el ítem FMT en el menú de barra y haga clic en Close. 
a. Ahora debería ver FMT listado en el panel superior de su ventanilla de 

QGIS.  
 

Configuración y Ajustes de la Carpeta 

Ahora debemos modificar la ubicación de las rutas para el lugar donde se van a 
almacenar las salidas del FMT.  

10. Abra el Windows Explorer y navegue a la carpeta del plug-in FMT 
(C:\Users\<username>\.qgis2\python\plugins).  

11. Abra el archivo llamado Config.ini. Tendrá que editar las líneas img_src y 
scene_dir para mostrar la ruta a su lugar de almacenaje designado. 

Así es cómo se ve el archivo inicialmente:  
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Aquí hay un ejemplo de cómo se ve el archivo modificado. Note que el nombre de su 
ruta será diferente y reflejará el lugar donde se encuentran sus archivos FMT:  

 

12. Asegúrese guardar los cambios al archivo Config.ini antes de cerrarlo.  

Configuraciones para la Base de Datos 

El plugin también viene por defecto con una base de datos SQLite (“FireInfo.sqlite”) que 
hay que conectar con QGIS. 

13. Vuelva a su ventanilla de QGIS.  
14. Para establecer la conexión a la base de datos FireInfo.sqlite seleccione Layer 

> Add Layer > Select Add SpatiaLite Layer 
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15. En la ventanilla Add SpatialLite Layer haga clic en New. Ahora navegue a su 

carpeta FMT (C:\Users\<username>\.qgis2\python\plugins) y haga clic en 
FireInfo.sqlite y después en Open.  

 
16. Regrese a la ventanilla Add SpatialLite Layer y haga clic en Connect y 

después en Close. La conexión con la base de datos se ha establecido – el 
plugin está listo para usarlo. 
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Parte 2: Usando la Herramienta FMT  

Para este ejercicio usaremos el incendio Paradise como nuestro estudio de caso. El 
incendio Paradise ocurrió en el Parque Nacional Olímpico en el estado de Washington 
de mayo hasta noviembre de 2015, el cual fue un año de sequía severa en la región. 
Las imágenes Landsat ya están incluidas en la descarga del plugin FMT, así que no 
necesitará ordenar los datos de la página en línea de EROS Science Processing 
Architecture (ESPA). Para más detalles sobre cómo ordenar datos de ESPA, refiérase 
al manual del usuario del QGIS-Fire Mapping Tool (FMT). 

1. Inicie el plugin de evaluación de incendios haciendo clic en FMT en el panel 
superior y haciendo clic en Fire Mapping Tool. 

2. Todos los archivos ESPA .tar.gz deben estar ordenados en la siguiente carpeta: 
QGIS_FMT_Plugin_V1_0_1>FireMappingQgis>targz. Para procesar las 
imágenes de ESPA, haga clic en el botón Process ESPA Data. 

a. Se abrirá una ventanilla que dice, “Do you want the output files in Albers 
projection?” Haga clic en No. 

b. El procesamiento tarda unos minutos. Una vez que esté completo, se 
abrirá otra ventanilla de diálogo que dice “Processing ESPA files 
completed”. Haga clic en OK. 

3. Haga clic en Search y después en Search by Name. En Incident Name teclee 
Paradise y haga clic en Search. Esto automáticamente abrirá la información 
sobre el incendio Paradise para la herramienta FMT.  

4. Haga clic dos veces en el archivo Paradise en la parte superior. Se abrirá una 
ventanilla llamada Load Images. Llénela con estos parámetros:  

a. Image Selection: Collections Data 
b. Start Year: 2014 
c. End Year: 2016  
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5. Haga clic en OK. Cuando se abra una ventanilla diciendo Number of Images 

loading:2, haga clic en OK.  

Una vez que esté completo el proceso, debe ver las imágenes visualizadas 
nuevamente en su ventanilla de QGIS.  
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Ahora podemos realizar el mapeo del incendio.  

6. En la ventanilla de FMT, haga clic en Create New Mapping. En la ventanilla de 
Create Scene Pair agregue estos parámetros:  

a. Assessment Strategy: Extended 
b. Pre Image: 8047027201472… (ésta es la imagen pre-quema de 2014) 
c. Post Image: 7047027206181… (ésta es la imagen post-quema de 2016) 
d. Todos los demás parámetros deben quedar con sus valores 

preprogramados  
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7. Haga clic en Save Mapping.  

El mapeo que acaba de realizar ahora debe aparecer en su lista ID. Probablemente 
esté listado como ID 5.  

8. Desplácese hacia abajo y haga clic en la línea de mapeo que acaba de crear (ID 
5) para que se vuelva azul. Ahora haga clic en Run Scene Prep. Este paso 
debería completarse rápidamente. Una vez que se realice el proceso, haga clic 
en OK.  

a. Este paso crea un dNBR utilizando las escenas que ingresaron. La salida 
se registra en la carpeta …/firemappingqgis/img_proc/landsat/. 

9. Asegúrese que su ID esté resaltado en azul nuevamente y haga clic en Run Fire 
Prep. Una vez que el proceso se ejecute, haga clic en OK.  

a. Este paso crea una carpeta con el nombre de Fire-ID en la carpeta 
FireMappingQgis/event_prod/fire/year/fire_id/mapping_id y la llena con 
archivos modelo para el perímetro del incendio y la máscara de 
nubes/sombra y un archivo de proyecto .qgis. Cada mapeo del mismo 
incendio crea una nueva carpeta mapping_id. 

Ahora vamos a delinear y mejorar la visualización de la imagen.  

10. En el FMT, resalte el mismo ID (ID 5, Extended output) y haga clic en Delineate 
Perimeter. Esto cargará la reflectancia de la escena pre- y post-incendio, la 
NBR pre- y post-incendio y las imágenes de la dNBR al Layers Panel.  

a. Aparecerá una ventanilla que dice “Qgis Project files are loaded”. Haga 
clic en OK. 

El plugin QGIS aplica un “estiramiento” de imagen preprogramado y el usuario 
puede ajustar la luminosidad, el contraste y las combinaciones de bandas para 
mejorar la visualización del incendio. La herramienta QGIS FMT cargará las 



 
Webinar Avanzado: Técnicas de Detección y Monitoreo de Incendios Forestales 

12 y 19 de julio de 2018 

 

http://arset.gsfc.nasa.gov/   15  

imágenes de reflectancia, de la NBR y dNBR con un estiramiento preprogramado. 
Sin embargo, el estiramiento preprogramado puede que no sea consistente entre 
las imágenes de reflectancia pre- y post-incendio. Para interpretar las imágenes de 
reflectancia pre-incendio y post-incendio, es mejor visualizarlas con el mismo 
estiramiento cromático multibanda para que los varios matices representen las 
mismas condiciones en el suelo en ambas imágenes. 

11. En la ventanilla de QGIS, haga clic en View > Toolbars > Raster toolbar. 
Resalte la imagen de reflectancia post-incendio                                                           
(Post_Scene_Refl_70470272016081101T1_REFL.TIF) en el Layers Panel. 
Haga clic en los varios mejoramientos de imágenes y note cómo cambian sus 
imágenes.  

 
12. Haga clic con el botón derecho en la imagen de reflectancia post-incendio en el 

Layers Panel y haga clic en Properties > Style. Bajo Band Rendering, ajuste 
el valor Min para las bandas Red, Green y Blue a 0 y el valor Max para las 
bandas Red, Green and Blue a 127. Haga clic en Apply y después en OK.  
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13. Repita el paso 11 para la imagen de reflectancia pre-incendio 

(Pre_Scene_Refl_804702720014072901T1_REFL.TIF).  

Ahora vamos a delinear el perímetro del incendio/límite del área quemada. Cuando 
examinamos las imágenes post-incendio para una cicatriz de quema, por lo general 
ampliamos en el área de las coordenadas de latitud y longitud del incendio. La 
ubicación del incendio Paradise Fire fue 47.698 latitud y -123.803 longitud.  

14. Haga clic en View > Zoom In. Después desplace su ratón lentamente sobre la 
porción norte central de la imagen. Mire la casilla Coordinate al fondo de QGIS. 
Mueva el cursor hasta acercase a estas coordenadas: 440185, 5283622. Ahora 
amplíe esta región. Va a ser difícil ver esas coordenadas exactas, pero si está 
cerca y amplía esa región, empezará a ver la cicatriz de quema. Observe el 
cuadro rojo en la imagen siguiente. 
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Una vez que haya ampliado la ubicación aproximada del incendio, si la combinación de 
bandas de las imágenes de Landsat es la siguiente: 6 (roja), 4 (verde) y 3 (azul), la 
cicatriz generalmente aparecerá en el espectro cromático entre morado y rojo.  

15. Para revisar esto, haga clic en la imagen Post_Scene_Refl en el Layers Panel 
y haga clic en Properties. Bajo la pestaña Style, verá (Red band: Band 6, Green 
band: Band 4 y Blue band: Band3). Haga clic en OK.  

Por favor note que otros disturbios podrán aparecer en colores similares a las 
cicatrices de quema. Debe tener cuidado para cerciorarse de que un área en 
particular en verdad sea una cicatriz de quema de un incendio.  

16. Encienda la imagen de reflectancia Post_Scene_Refl y apague la imagen de 
reflectancia Pre_Scene_Refl en el Layers Panel haciendo clic en la X al lado 
del nombre de la imagen. 

17. Alterne entre tener las imágenes pre- y post- incendio encendidas y apagadas. 
Debería notar una diferencia en esta región con la imagen post-escena 
mostrando una región roja notoria. Ésta es el incendio Paradise.  
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18. Haga clic en View > Toolbars y haga clic en las barras Advanced Digitizing y 
Digitizing.  

19. Haga clic con el botón derecho en el shapefile Burned_Area_Bndy y haga clic 
en Toggle Editing.  

a. En el panel superior, haga clic en Add Feature . Haga clic con el 
botón izquierdo para crear la forma del perímetro del incendio. Después 
de tener el área dibujada, haga clic en Save Edits para guardar su nuevo 
polígono. Para delinear la forma, haga clic en cualquier lugar del mapa 
para empezar el polígono. Aparecerá una línea roja que identifica el borde 
exterior del polígono. Una vez que termine, haga clic con el botón derecho 
y aparecerá una ventanilla que dice ID, teclee 1 y haga clic en OK. Ahora 
verá su polígono visualizado en el mapa.  

20.  Ahora apague el Toggle Editing. Su perímetro debería verse algo parecido a la 
imagen siguiente.  

 
21. Volviendo al FMT, resalte su ID (ID 5, Extended output) de mapeo y haga clic en 

Subset. Cuando el procesamiento esté completo, aparecerá una ventanilla que 
dice Subset step is Complete. Haga clic en OK. Todas las imágenes 
recortadas se grabarán en la carpeta del evento de incendio. Para revisar estos 
archivos, haga clic en el botón Open Event Folder. 

a. Esto abrirá la carpeta del evento para su mapeo (probablemente se llame 
mtbs_5). Por ejemplo, debe ver una imagen con _dnbr.tif al final del 
nombre del archivo. 
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b. Cierre la ventanilla de la carpeta.  

Ahora vamos a calcular la dNBR relativa, la cual es otro índice de severidad de quema 
útil. Mientras que la dNBR es una medida de la diferencia absoluta entre las NBRs pre- 
y post-incendio, la RdNBR trata de cuantificar la diferencia relativa. Para calcular la the 
RdNBR, primero hay que determinar el desfase “dNBR offset” (es decir, el valor dNBR 
medio de la vegetación sin quemar). El paso Subset (ver 21) estima este valor a partir 
de todos los pixeles de la dNBR sin quemar fuera del perímetro. Sin embargo, el valor 
estimado podría ser impreciso si la cobertura terrestre no es representativa de la 
vegetación quemada que rodea el incendio. En este caso, debe determinar el valor del 
desfase manualmente.  

22. En la ventanilla de QGIS, haga clic en Layer > Create Layer > New Shapefile. 
Cuando aparezca la ventanilla, seleccione Polygon. Bajo el panel File 
Encoding, asegúrese de tener la proyección correcta Selected CRS 
(EPSG:32610, WGS 84/UTM zone 10N). Al lado de Name, teclee dnbr. Haga 
clic en OK y después guarde el archivo como dnbr_offset en su carpeta 
mtbs_5. 
(FireMappingQgis\event_prods\fire\2015\wa4769812380320150615\mtbs_5). El 
nuevo archivo será agregado automáticamente a su mapa.  
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23. Resalte el archivo dnbr_offset y haga clic en Toggle Editing. En el panel 

superior, haga clic en Add Feature . Delinee uno o más polígonos que 
encierre áreas sin quemar representativas de la vegetación que sí se quemó. 

a. Tome en cuenta las pendientes, el aspecto, los tipos de vegetación, la 
cobertura nubosa y las líneas de escaneo de Landsat 7 ETM+ en ambas 
imágenes. Si el incendio quemó diferentes tipos de vegetación, las 
muestras de áreas deberían reflejar los tipos y las proporciones de la 
vegetación quemada. Además, al hacer el mapa del polígono sobre las 
líneas de escaneo (las franjas negras en la imagen) va a introducir 
valores de No Data (-32768) (no hay datos) en las estadísticas de la 
zona. No incluya estas áreas en su polígono. (Ver el paso 25). 

b. Para delinear la forma, haga clic en cualquier lugar del mapa para 
comenzar con el polígono. Aparecerá una línea roja que identifica el 
borde exterior del polígono. Asegúrese no mapear sobre las líneas de 
escaneo. Una vez que haya terminado, haga clic con el botón derecho y 
aparecerá una ventanilla que dice ID, teclee 1 y haga clic en OK. Ahora 
verá su polígono visualizado en el mapa.  
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c. Haga clic en el archivo dnbr_offset y en Save Edits y después desactive 
el Toggle Editing.  

 
 

24. Encienda el Zonal Statistics Plugin haciendo clic en Manage and Install 
Plugins > Installed y después desplácese hacia abajo hasta Zonal Statistics 
Plugin y señálelo poniendo una X en la casilla. Haga clic en Close.  

 

25. Haga clic en Raster > Zonal Statistics > Zonal Statistics. En Raster Layer, 
seleccione la imagen Post_Scene_dbr, en Polygon Layer, seleccione 
dnbr_offset. Desmarque las casillas Count y Sum, asegúrese que las casillas 
Mean y Standard Deviation estén marcadas y haga clic en OK.  
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26. Vuelva al FMT. En la casilla azul Perimeter Confidence, seleccione High. En la 
casilla roja Analysis Type, seleccione dnbr. Los valores en el dNBR Offset y el 
SD Offset deberían ser los valores de las estadísticas zonales que acaba de 
calcular. Posiblemente sean diferentes dependiendo del polígono que creó.  

a. Haga clic en OK en la casilla de Perimeter Confidence. Aparecerá una 
ventanilla con el estatus “Shape Attributes are Populated”. Haga clic en 
OK. 

27. Haga clic en el botón RdNBR.  
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28. Haga clic en el botón Open Event Folder para abrir la carpeta del evento del 
incendio Paradise. Dentro de esta carpeta verá el archivo _rdnbr.tif. Agregue el 
archivo del sub-set de la RdNBR a su Layers Panel. 

29. Haga clic con el botón derecho en la imagen _rdnbr y haga clic en Properties > 
Style. Mantenga todas las configuraciones con sus valores preprogramados, 
pero fije el Color gradient Min a -300 y el Max a 397. Haga clic en OK. 

a. Notará las líneas de escaneo negras en su imagen. Esto es porque es 
una imagen de Landsat 7. Si tiene curiosidad sobre el tema de las líneas 
de escaneo con Landsat 7, puede encontrar más información al respecto 
aquí: https://landsat.usgs.gov/landsat-7  

30. Siempre es buena idea guardar su mapa durante el proceso. Haga clic en Save 
y guarde su mapa de QGIS en su carpeta de este trabajo (mtbs_5) como 
FTM.qgis.  
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Parte 3: Mapa de Severidad de Quema Temático  

El paso de crear el sub-set con el FMT estimó los umbrales bajo, moderado, y alto 
(Low, Moderate y High) en base a un análisis estadístico de los pixeles dentro del 
perímetro delineado. 

1. En el FMT, haga clic en el botón Threshold para aceptar los valores generados 
por la creación del sub-set. Después de hacer clic en Threshold, verá escrito 
Threshold Completed a lo largo del panel inferior izquierdo de QGIS.  
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2. Agregue la imagen de los umbrales (Threshold) a QGIS. Haga clic en el icono de 
Add Raster Layer . Navegue a su carpeta mbts_5 y seleccione el archivo que 
termina en dbnr6.tif. Haga clic en Open. 

Revise el resultado temático para ver si conserva los patrones que se vieron en la 
dNBR en tonos de gris. Inicialmente, la estimación visual de los umbrales es una buena 
forma de evaluar los umbrales preprogramados o de recolectar datos de campo para 
comparar con los valores dNBR y, con el tiempo, desarrollar un conjunto de umbrales 
preprogramados (“Default Thresholds”) para su área de interés.  

Para más información, consulte la documentación FIREMON y el índice de quema 
compuesto (composite burn index o CBI): 
https://www.frames.gov/documents/projects/firemon/FIREMON_LandscapeAssessment
.pdf 
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Después de revisar los umbrales, Posiblemente decida que quiere ajustar los 
umbrales manualmente para representar mejor la posible severidad de quema en el 
suelo. Para hacer esto, va a querer revisar imágenes dNBR, RdNBR y de 
reflectancia visualmente. 

3. Haga clic en el icono de Add raster Layer  y agregue la imagen terminando 
en _nbr.tif. Haga clic con el botón derecho en la imagen _nbr y haga clic en 
Properties > Style. Mantenga todas las configuraciones con su valor 
preprogramado, pero fije el Color gradient Min como -300. Haga clic en OK. 

Ahora debe tener sus imágenes _nbr.tif, _dnbr6.tif y _rdnbr.tif cargadas en QGIS. 
Las RdNBR se cargan con una rampa de color (negro a blanco) por defecto para 
imágenes de 16 bits con firma de banda singular. 

4. Haga clic y arrastre la imagen Post_Scene_dNBR a la parte superior del Layers 
Panel. Acomode las capas restantes en el siguiente orden: reflectancia pre-
incendio, nbr pre-incendio, reflectancia post-incendio, nbr post-incendio y 
RdNBR y desactive las imágenes de reflectancia para que sólo las dNBR y 
RdNBR estén activas (es decir, señaladas). 
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5. Para codificar la imagen Post_Scene_dNBR con colores, haga doble clic en ella 
y se abrirá la ventanilla Properties. Seleccione Style. Esta interfaz le permitirá 
codificar la imagen dNBR (y la RdNBR) con colores para ayudar a estimar los 
umbrales de severidad de quema. 

Por defecto la dNBR se genera como una imagen en tonos de gris de banda 
singular con un estiramiento negro a blanco utilizando los valores mínimo y 
máximo estimados. Debería saber el rango de valores real.  

6. Cambie el Render type a Singleband pseudocolor. Configure el Interpolation 
como Discrete.  

7. Si el valor Min es menor que -500, póngalo en -500. Si el valor Max es mayor 
que 1000, póngalo en 1000. 

8. Para el color, seleccione la rampa de color Greys, haga clic en Invert. 
Seleccione Equal Interval como el Mode. Note que Classes por defecto tiene el 
valor de 5.  

9. Haga clic en el botón Classify, después en Apply. Ahora la imagen dNBR está 
visualizada con cinco niveles de gris, dos de los cuales cubren el área quemada. 
Cada intervalo de clase cubre aproximadamente 100 valores dNBR dependiendo 
de su imagen. 
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10. Vuelva a la interfaz Style e ingrese el valor Min como -200 y el valor Max como 
900 en la interfaz Render type> Singleband pseudocolor. Seleccione Equal 
Interval nuevamente y fije el número de clases en 23 y después haga clic en 
Classify y Apply. Haga clic en OK y visualice su imagen.  

Con 23 clases, todos los niveles de gris se pueden ver en la ventanilla de la rampa 
de color. Cada intervalo cubre aproximadamente 40 niveles dNBR (los valores o 
“Values” están visualizados como decimales, pero los valores dNBR reales son 
íntegros). Puede que los intervalos de 40 sean demasiado brutos para la precisión 
(± 10) pero esto se puede resolver después.  
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Observe la imagen dNBR de esta producción. Hay un buen contraste y los niveles de 
gris dentro del área quemada varían de blanco brillante a tonos de gris medios y más 
oscuros y delinean los patrones de severidad de quema dentro del incendio. Las áreas 
no quemadas son mucho más oscuras. Primero, encuentre los valores dNBR que 
corresponden con los umbrales de quemado/no quemado bajo y alto. 

11. Haga clic y amplíe cada imagen en turno para ver cómo los patrones de la dNBR 
corresponden con las imágenes de reflectancia post- y pre-incendio. Cuando 
termine, amplíe la extensión del límite del área quemada (aprox. 1:50,000) 

Mientras se van coloreando los umbrales dNBR, compare los nuevos umbrales con 
la imagen de reflectancia post-incendio y una versión no coloreada de la imagen 
dNBR también.  

12. En el Layers Panel, haga clic con el botón derecho en la imagen 
Post_Scene_dNBR y seleccione Duplicate. Esto crea una copia de la imagen 
dNBR en la lista de contenidos que concuerda con la original en cuanto a 
propiedades estilísticas (min y max de -200 y 900 y 23 clases). Cámbiele el 
nombre a esta imagen a duplicate haciendo clic con el botón derecho en el 
archivo en el Layers Panel y después haga clic en Rename.  
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a. La imagen en la que se editan los valores de intervalos no se copia. Así 
que haga doble clic en el archivo duplicado y haga clic en Apply y 
después en OK y esos cambios deberían ser visibles.  

13. Haga clic para apagar las demás imágenes en el Layers Panel para que no se 
vean a través de las áreas transparentes del duplicate.  

14. Haga doble clic en la imagen llamada duplicate en el índice de contenidos y 
abra la pestaña Properties > Style. Ajuste el tamaño de la ventanilla para 
ahorrar espacio. (Algunos de los parámetros de generate new color map 
revierten a sus valores preprogramados: Invert no está señalado, Mode es 
“equal area” con 23 clases etc.). 

Calculando el umbral de severidad de quema bajo: 

Comenzaremos con tratar de determinar el valor dNBR para el umbral quemado y no-
quemado. Este punto de inicio bajo a menudo cae en algún lugar entre los valores 
dNBR de 0 y 100 (Key y Benson 2006). Muchas veces, el punto de inicio de severidad 
bajo es fácil de discernir porque es el umbral en el cual hay una diferencia distinta en el 
colorido entre áreas quemadas y no-quemadas dentro de la imagen dNBR.  

15. Con la pestaña Style del archivo duplicate abierta, comience a partir del valor 
más bajo (aprox. -152) y haga doble clic en la casilla Color box. La ventanilla 
Change color aparece con varias formas de definir y guardar colores. Esta 
categoría se referirá a las líneas de escaneo, así que hagamos éste color negro. 
Haga clic en Apply y después en OK y cierre la casilla Properties.  

16. Haga clic en el siguiente par de casillas con valores negativos (ej. -104, -56.5, -
8.7) y cambie el color a un verde oscuro para indicar no-quemado. Haga clic en 
Apply y en OK y después visualice la imagen.  

a. Nota: Para poder copiar un color a múltiples categorías puede copiar la 
notación HTML (Ej.: #067914) de la primera categoría cromática y pegarla 
en la categoría siguiente.  

b. Note también que sus valores de umbral podrían variar un poco, pero este 
proceso se realizará de manera similar. 
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Las pequeñas áreas de verde oscuro al norte del incendio parecen ser sombras de 
nubes y/o áreas estériles pre-incendio que son más verdes en la imagen post-incendio.  

 

Ahora vamos a probar el umbral bajo. El valor del desfase Post_Scene_dNBR se 
calculó que era 3 con una desviación del estándar de 32 (vea el paso RdNBR más 
arriba) así que el umbral quemado y no-quemado, también conocido como el umbral 
bajo, probablemente está cerca de 3 más ~2 desviaciones del estándar (3 + 64 = 67). 
Ésta es sólo una estimación inicial; una interpretación visual de las imágenes dNBR y 
post-incendio puede ser más exacta que el umbral estimado. Note que éste a menudo 
es un proceso iterativo que puede requerir de ensayo y error.  

17. Se estima que el umbral bajo esté cerca de 70. ¿Pero qué de la siguiente 
categoría (39.1)? Dele a esta categoría un color azul claro y haga clic en Apply 
y después en OK.  
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18. Pareciera que esta categoría está casi completamente fuera de nuestra área 
quemada, así que cambiémosle el color de esa categoría por un verde oscuro. 
Repita ese paso para las siguientes dos categorías (87 y 135). Los colores 
asignados a la imagen para cualquier nivel son valores iguales y menores al 
‘valor’ que se muestra en la rampa de color. 
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19. Ahora veamos la próxima categoría (183) como baja y hagamos el color azul 
celeste. Pareciera que estos pixeles están apareciendo alrededor del perímetro 
del incendio, así que aparenta ser una categoría apropiada.  

 

20. Aplique la misma categoría azul celeste a las cuatro siguientes categorías (230, 
278, 326 y 374) y observe el mapa. ] 
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Entonces, ¿cuáles son los valores correctos para los umbrales? No existe forma 
definitiva de discernirlos sin observaciones en el campo. Aun así, es algo subjetivo. La 
habilidad de interpretar mejora con la experiencia, especialmente en combinación con 
observaciones en el campo. El proyecto MTBS estimó un valor dNBR de 100 como el 
umbral bajo para este incendio. Para que haya consistencia entre diferentes analistas 
del proyecto MTBS, todos mapearán el mismo incendio y compararán sus resultados. 
Se dice estar de “acuerdo” si los valores de todos los analistas están dentro de 50 para 
sus umbrales elegidos. 

21. Pruebe los valores de quema moderada en las siguientes cuantas categorías 
(422, 470, 517, 565).  
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Ahora, vamos a estimar el umbral de alta severidad mediante la RdNBR. Nota: La 
RdNBR no funciona necesariamente en todas partes y la siguiente metodología es sólo 
un punto inicial para la estimación del umbral de alta severidad. Para estimar el umbral 
de alta severidad, el proyecto MTBS utiliza la imagen RdNBR para ayudar a determinar 
el umbral de alta severidad en la imagen dNBR. Miller y Thode (2007) investigaron 
varios incendios en California y hallaron que los valores de umbral RdNBR específicos 
estaban altamente correlacionados con estimaciones de alta severidad de quema en el 
suelo. Recomendaron diferentes umbrales RdNBR para evaluaciones extendidas 
(umbral: 640) versus evaluaciones iniciales (umbrales: 750).  

22. Apague la imagen Post_Scene_dNBR y las capas de duplicate por ahora.  
23. Fije el umbral RdNBR alto como 640. Para hacer esto, visualice la RdNBR en 

Singleband Pseudocolor. En la pestaña Properties > Style, ingrese los 
valores -700 y 1100 como Min y Max y clasifique 23 de negro a blanco.  
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24. Utilizando los métodos recién descritos, utilice el rojo para significar valores de 
RdNBR ≥ 640. Cierre la pestaña Style. Mueva la imagen RdNBR debajo de la 
imagen dNBR. 
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Ahora, vamos a utilizar la imagen Post_Scene_dNBR para tratar de igualar las 
categorías cromáticas de las áreas de alta intensidad de quema con aquellas indicadas 
en la imagen RdNBR. 
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25. Apague la imagen Post_Scene_dNBR y asegúrese que las categorías 
cromáticas correspondan con los tonos de gris que se visualizaron antes 
(Singleband Pseudocolor, Greys, rampa de color con Min y Max = -200, 900; 23 
clases de intervalos iguales, discretos etc.).  

26. Empiece por los valores más altos en la rampa de color y cambie cada nivel a 
rojo y compare cada actualización con la imagen RdNBR. Encienda la capa 
Post_Scene_dNBR y cada vez que cambie un color gris a rojo e intente hacer 
cuadrar los pixeles rojos en la imagen Post_Scene_dNBR_copy con los de la 
imagen RdNBR. 
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Parece que el siguiente nivel 565 de la Post_Scene_dNBR concuerda bien con la 
RdNBR. Ahora puede fijar el umbral Post_Scene_dNBR con un valor similar (565). 
Puede redondear al 10 o al 25 más cercano para evitar la implicación de una precisión 
de medición que en verdad no se puede discernir. 
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Ahora hemos estimado el umbral bajo como 87 y el umbral alto como 565.  

27. Apague la imagen Post_Scene_dNBR y aplique los valores de categoría altos a 
la imagen duplicate.  

 

28. Para guardar las categorías cromáticas que utilizó, haga clic en el icono Export 

Color Map to File  en la pestaña Style. Guarde el archivo en su carpeta de 
trabajo como burn_sev. La próxima vez puede importar estas categorías y 
colores en una futura imagen con la que trabaje. Esto le ahorrará tiempo y dará 
algo de consistencia.  

Algo más sobre el mapeo de umbrales de categorías: 

A menos que haya observaciones en el suelo para guiar la selección del umbral 
moderado, hay que estimar un valor visualmente que conserve los patrones vistos en la 
dNBR. Elegir un valor por la mitad entre los umbrales alto y bajo es un punto de inicio 
razonable. El valor 326 está a medio camino entre 87 y 565. Coloree los intervalos en 
tonos de gris de 326 a 565 amarillos (severidad moderada) y azul celeste para los 
intervalos de 87 a 326 (severidad baja). Si no hubo alta severidad dentro del perímetro 
del incendio (no hubo valores RdNBR en exceso de 640 para evaluaciones extendidas 
o 750 para evaluaciones iniciales), ingrese 9999 para el valor de severidad alta (high 
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severity value) y utilice técnicas de interpretación de imágenes para estimar un valor de 
severidad moderada (moderate severity value), eligiendo un valor que conserve los 
patrones principales de severidad de quema que se vieron en la dNBR. 

El “No Data Threshold” automáticamente está en -970 y representa valores dNBR que 
son artefactos y no representativos de la severidad de quema real. El “increased 
Greenness Threshold” automáticamente está en -150. Los valores dNBR menores que 
-150 representan áreas donde ha habido un incremento de vegetación. Por lo general 
no hay motivo para cambiar este valor a menos que el valor dNBR sin quemar medio 
(el desfase) sea significante menos de cero, es decir. < -30. En ese caso puede que 
quiera reducir este umbral a -180. 

29. Vuelva a su ventanilla FMT. Cambie los valores Threshold para reflejar aquellos 
que eligió. 

a. Low: 87 
b. Moderate: 326 
c. High: 565 

30. Ingrese cualesquiera comentarios sobre el mapeo (mapping comments) que 
sean apropiados y haga clic en el botón Threshold. 

 
31. Una vez que acabe una evaluación de incendio, seleccione Complete del menú 

desplegable y haga clic en Update Mapping. El Mapping Status cambia de in-
progress a complete. Se puede cambiar de vuelta a in-progress en caso de 
que el/la analista necesite hacer revisiones. 
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32. Haga clic en Generate Metadata. Esto generará un archivo de texto que 
contiene todos los parámetros asociados con la evaluación de severidad del 
incendio y lo agregará a la carpeta del incendio. 
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Conclusión 

El FMT permite a los usuarios mapear el perímetro y la severidad de quema de 
incendios de su interés que posiblemente no estén incluidos en evaluaciones de 
incendios de MTBS o que podrían tardar demasiado en ser publicados por MTBS. En 
este ejercicio, usted adquirió un entendimiento de este proceso, incluyendo cómo: 

1. descargar y configurar el FMT Plugin 
2. procesar datos ESPA  
3. delinear el perímetro de un incendio 
4. crear sub-sets de imágenes 
5. crear umbrales de severidad de quema 

Para más información sobre el proceso evaluativo en su totalidad, lea la guía “QGIS 
FMT User Guide” que está incluida en el paquete de descarga del FMT.  

Recursos en Línea Adicionales 
FIREMON y documentación sobre el “composite burn index” (CBI): 
https://www.frames.gov/documents/projects/firemon/FIREMON_LandscapeAssessment
.pdf. 

Monitoring Trends in Burn Severity (MTBS): https://mtbs.gov/  
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